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1 Working with HDF5 Files

1 Working with HDF5 Files
HDF5 is the preferred format for storing APDM movement monitor data. It is a standard format for scientific

data that is efficient and widely supported. It uses less space than CSV, is faster to load, and supports more

structured data. This section will cover the organization of the APDM movement monitor data and the basics

of reading HDF5 files in MATLAB.

1.1 HDFView

A free program called HDFView (http://www.hdfgroup.org/hdf-java-html/hdfview/) can be used to

explore, plot, and export this data into other formats. A variety of free open source tools for working with HDF

files are also available at http://www.hdfgroup.org/HDF5/release/obtain5.html.

1.2 Data Organization

HDF5 files are organized like a file structure. The root of the file contains two attributes. One is a list of

monitor IDs that have data stored in this file. The other is a version number for the organization of the HDF

5 file.

1.3 File Structure

1.3.1 Version 5

• Annotations Table containing annotations and button events

– Time Annotation time in epoch microseconds

– Case ID A movement monitor case ID associated with the annotation

– Annotation The annotation string

• Sensors Group containing sensor data

– XI-XXXXXX Group containing data from the monitor with this case ID. There is one of these groups for each sensor

* Accelerometer Dataset containing accelerometer data

· Lower Limit Attribute specifying the lower limit of the sensor

· Upper Limit Attribute specifying the upper limit of the sensor

· Name Attribute containing the name of the sensor

· Units Attribute containing the units used to report the sensor measurements

* Barometer Dataset containing barometer data

· Lower Limit Attribute specifying the lower limit of the sensor

· Upper Limit Attribute specifying the upper limit of the sensor

· Name Attribute containing the name of the sensor
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1 Working with HDF5 Files

· Units Attribute containing the units used to report the sensor measurements

* Gyroscope Dataset containing gyroscope data

· Lower Limit Attribute specifying the lower limit of the sensor

· Upper Limit Attribute specifying the upper limit of the sensor

· Name Attribute containing the name of the sensor

· Units Attribute containing the units used to report the sensor measurements

* Magnetometer Dataset containing magnetometer data

· Lower Limit Attribute specifying the lower limit of the sensor

· Upper Limit Attribute specifying the upper limit of the sensor

· Name Attribute containing the name of the sensor

· Units Attribute containing the units used to report the sensor measurements

* Temperature Dataset containing internal temperature data

· Lower Limit Attribute specifying the lower limit of the sensor

· Upper Limit Attribute specifying the upper limit of the sensor

· Name Attribute containing the name of the sensor

· Units Attribute containing the units used to report the sensor measurements

* Time Dataset containing timestamps in units of microseconds since 0:00 Jan 1, 1970 UTC

· Units Attribute specifying the units used to store the timestamps

* Configuration Group containing attributes that specify the configuration of the sensor

· Accelerometer Enabled 1 for enabled. 0 for disabled

· Gyroscope Enabled 1 for enabled. 0 for disabled

· Magnetometer Enabled 1 for enabled. 0 for disabled

· Barometer Enabled 1 for enabled. 0 for disabled

· Button Event 0 = String configured to represent a button 0 event

· Button Event 1 = String configured to represent a button 1 event

· Button Event 2 = String configured to represent a button 2 event

· Button Event 3 = String configured to represent a button 3 event

· Calibration Disabled 1 to apply only the sensor data sheet typical conversion factors. 0 to use calibration

data stored on the device

· Label 0 Custom label for this sensor. This is what is displayed on the LCD

· Location Sensor location on the body

· Sample Rate Sensor output data rate

· Timezone Timezone code

· Timezone Offset Timezone offset in units of hours from UTC

· Wireless Channel Wireless channel

· Wireless Protocol 0 for wireless disabled, 1 for synchronized logging, 2 for wireless streaming

· Wireless Latency (ms) Configured maximum acceptable wireless latency

· Wireless rate divider Data is streamed at the sample rate divided by this factor

* Metrics Group containing information on the status of the sensor

• Processed Group containing derived signals from the sensor data

– XI-XXXXXX Group containing derived signals from the sensor with this case ID

* Orientation Dataset containing quaternions which can be used to rotate sensor data from the sensor frame to a

local NWU reference frame

6



1 Working with HDF5 Files

1.3.2 Versions 3 and 4

• MonitorLabelList Attribute containing an array of monitor labels in the same order as the CaseIdList

• CaseIdList Attribute containing an array of monitor case IDs in the same order as the MonitorLabelList

• FileFormatVersion Attribute containing the file format version (3)

• Annotations Table containing annotations

– Time Annotation time in epoch microseconds

– Case ID A movement monitor case ID associated with the annotation

– Annotation The annotation string

• AA-XXXXXX A group is included in the file for each monitor in the CaseIdList, with the name equal to the case ID

– FilteredDataPopulated (version 4) Attribute indicating the present of the filtered data group

– SampleRate Attribute containing the output data rate for the monitor

– DecimationFactor Decimation factor for the monitor’s internal processing

– ModuleID The module ID for the monitor

– TimeGood Flag indicating whether the time has been set on the monitor since it powered on

– RecordingMode One of: ”Wireless streaming”, ”Synchronized logging”, or ”Unsynchronized logging”

– DataMode Indicates whether the data was retrieved wirelessly or copied from the monitor’s internal storage while

docked. One of: ”Streamed wirelessly” or ”Logged to monitor”

– AccelerometersEnabled 1 for enabled, 0 for disabled

– GyroscopesEnabled 1 for enabled, 0 for disabled

– MagnetometersEnabled 1 for enabled, 0 for disabled

– DecimationBypass Internal use, deprecated

– CalibrationVersion Version of the calibration data used to convert from raw samples to calibrated SI units

– VersionString1 Firmware version string 1

– VersionString2 Firmware version string 2

– VersionString3 Firmware version string 3

– CalibratedDataPopulated (version 3) 1 for populated, 0 for unpopulated

– CalibratedData (version 4) Calibration data for the monitor

– LocalTimeOffset Time in microseconds to add to UTC to convert to local time

– SyncValue Dataset containing the internal sync value for each sample

* Units Attribute string containing the timestamp units (1/2560th of a second since 0:00 Jan 1, 1970 UTC)

– Time Dataset containing a timestamp for each sample

* Units Attribute string containing the units (microseconds since 0:00 Jan 1, 1970 UTC)

– ButtonStatus Dataset containing the button status for each sample (1==pressed, 0==unpressed)

– Calibrated Group containing calibrated data

* Accelerometers Dataset containing accelerometer data (Nx3)

· Units Attribute string containing the accelerometer units (m/s2)

· Range Attribute containing the range setting for the accelerometer (2g or 6g)

· Gravity (version 4) Attribute indicating the gravity constant used in orientation estimation

* Gyroscopes Dataset containing gyroscope data (Nx3)

· Units Attribute string containing the gyroscope units (rad/s)

* Magnetometers Dataset containing magnetometer data (Nx3)

· Units Attribute string containing the magnetometer units (µT)
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1 Working with HDF5 Files

* Temperature Dataset containing the temperature (Nx1)

· Units Attribute string containing the temperature units (◦C)

· EarthFieldMagnitude (version 4) The field constant used in orientation estimation

* TemperatureDerivative Dataset containing the temperature derivative (Nx1)

· Units Attribute string containing the temperature derivative units (◦C/s)

* Orientation Dataset containing the orientation quaternion (Nx4). The orientation is relative to a (magnetic) north,

west, up reference frame. The scalar component of the quaternion is the first element.

– Raw Group containing raw data if selected during import

* Accelerometers

* Gyroscopes

* Magnetometers

* DataFlags

* OptData

* Temperature

* TemperatureDerivative

– Filtered (version 4) Filtered data set. This set is intended for post-processed data. Currently the gyro biases are

removed from the gyroscope signals. In the future, additional filtering may be implemented.

* Accelerometers

* Gyroscopes

* Magnetometers

1.3.3 Version 3

• MonitorLabelList Attribute containing an array of monitor labels in the same order as the CaseIdList

• CaseIdList Attribute containing an array of monitor case IDs in the same order as the MonitorLabelList

• FileFormatVersion Attribute containing the file format version (3)

• Annotations Table containing annotations

– Time Annotation time in epoch microseconds

– Case ID A movement monitor case ID associated with the annotation

– Annotation The annotation string

• AA-XXXXXX A group is included in the file for each monitor in the CaseIdList, with the name equal to the case ID

– SampleRate Attribute containing the output data rate for the monitor

– DecimationFactor Decimation factor for the monitor’s internal processing

– ModuleID The module ID for the monitor

– TimeGood Flag indicating whether the time has been set on the monitor since it powered on

– RecordingMode One of: ”Wireless streaming”, ”Synchronized logging”, or ”Unsynchronized logging”

– DataMode Indicates whether the data was retrieved wirelessly or copied from the monitor’s internal storage while

docked. One of: ”Streamed wirelessly” or ”Logged to monitor”

– AccelerometersEnabled 1 for enabled, 0 for disabled

– GyroscopesEnabled 1 for enabled, 0 for disabled

– MagnetometersEnabled 1 for enabled, 0 for disabled

– DecimationBypass Internal use, deprecated

– CalibrationVersion Version of the calibration data used to convert from raw samples to calibrated SI units
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– VersionString1 Firmware version string 1

– VersionString2 Firmware version string 2

– VersionString3 Firmware version string 3

– CalibratedDataPopulated 1 for populated, 0 for unpopulated

– LocalTimeOffset Time in milliseconds to add to UTC to convert to local time

– SyncValue Dataset containing the internal sync value for each sample

* Units Attribute string containing the timestamp units (1/2560th of a second since 0:00 Jan 1, 1970 UTC)

– Time Dataset containing a timestamp for each sample

* Units Attribute string containing the units (microseconds since 0:00 Jan 1, 1970 UTC)

– ButtonStatus Dataset containing the button status for each sample (1==pressed, 0==unpressed)

– Calibrated Group containing calibrated data

* Accelerometers Dataset containing accelerometer data (Nx3)

· Units Attribute string containing the accelerometer units (m/s2)

· Range Attribute containing the range setting for the accelerometer (2g or 6g)

* Gyroscopes Dataset containing gyroscope data (Nx3)

· Units Attribute string containing the gyroscope units (rad/s)

* Magnetometers Dataset containing magnetometer data (Nx3)

· Units Attribute string containing the magnetometer units (µT)

* Temperature Dataset containing the temperature (Nx1)

· Units Attribute string containing the temperature units (◦C)

* TemperatureDerivative Dataset containing the temperature derivative (Nx1)

· Units Attribute string containing the temperature derivative units (◦C/s)

* Orientation Dataset containing the orientation quaternion (Nx4). The orientation is relative to a (magnetic) north,

west, up reference frame. The scalar component of the quaternion is the first element.

– Raw Group containing raw data if selected during import

* Accelerometers

* Gyroscopes

* Magnetometers

* DataFlags

* OptData

* Temperature

* TemperatureDerivative

1.3.4 Version 2

• MonitorLabelList Attribute containing an array of monitor labels in the same order as the CaseIdList

• CaseIdList Attribute containing an array of monitor case IDs in the same order as the MonitorLabelList

• FileFormatVersion Attribute containing the file format version (2)

• Annotations Table containing annotations

– Time Annotation time in epoch microseconds

– Case ID A movement monitor case ID associated with the annotation

– Annotation The annotation string

• AA-XXXXXX A group is included in the file for each monitor in the CaseIdList, with the name equal to the case ID
9
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– SampleRate Attribute containing the output data rate for the monitor

– DecimationFactor Decimation factor for the monitor’s internal processing

– ModuleID The module ID for the monitor

– TimeGood Flag indicating whether the time has been set on the monitor since it powered on

– RecordingMode One of: ”Wireless streaming”, ”Synchronized logging”, or ”Unsynchronized logging”

– DataMode Indicates whether the data was retrieved wirelessly or copied from the monitor’s internal storage while

docked. One of: ”Streamed wirelessly” or ”Logged to monitor”

– AccelerometersEnabled 1 for enabled, 0 for disabled

– GyroscopesEnabled 1 for enabled, 0 for disabled

– MagnetometersEnabled 1 for enabled, 0 for disabled

– DecimationBypass Internal use, deprecated

– CalibrationVersion Version of the calibration data used to convert from raw samples to calibrated SI units

– VersionString1 Firmware version string 1

– VersionString2 Firmware version string 2

– VersionString3 Firmware version string 3

– CalibratedDataPopulated 1 for populated, 0 for unpopulated

– LocalTimeOffset Time in milliseconds to add to UTC to convert to local time

– SyncValue Dataset containing the internal sync value for each sample

* Units Attribute string containing the timestamp units (1/2560th of a second since 0:00 Jan 1, 1970 UTC)

– Time Dataset containing a timestamp for each sample

* Units Attribute string containing the units (microseconds since 0:00 Jan 1, 1970 UTC)

– Calibrated Group containing calibrated data

* Accelerometers Dataset containing accelerometer data (Nx3)

· Units Attribute string containing the accelerometer units (m/s2)

· Range Attribute containing the range setting for the accelerometer (2g or 6g)

* Gyroscopes Dataset containing gyroscope data (Nx3)

· Units Attribute string containing the gyroscope units (rad/s)

* Magnetometers Dataset containing magnetometer data (Nx3)

· Units Attribute string containing the magnetometer units (µT)

* Temperature Dataset containing the temperature (Nx1)

· Units Attribute string containing the temperature units (◦C)

* TemperatureDerivative Dataset containing the temperature derivative (Nx1)

· Units Attribute string containing the temperature derivative units (◦C/s)

– Raw Group containing raw data if selected during import

* Accelerometers

* Gyroscopes

* Magnetometers

* DataFlags

* OptData

* Temperature

* TemperatureDerivative
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1.3.5 Version 1

This version is deprecated. All new files created will use the most recent version.

• Device List Attribute containing a list of monitors present in the file

• File Format Version Attribute containing the file version

• Annotations Table containing annotations

– Time Annotation time in epoch microseconds

– Device ID A movement monitor ID associated with the annotation

– Annotation The annotation string

• Opal xxx/ Group containing information about and data from monitor ID xxx

– Sample Rate Attribute containing the output data rate for the monitor

– Decimation Factor Decimation factor for the monitor’s internal processing

– Time Good Flag indicating whether the monitor has had its time set since turning on

– Decimation Bypass Internal use, deprecated

– Calibration Version Version of the calibration data used to convert from raw samples to calibrated SI units

– Version String1 Firmware version string 1

– Version String2 Firmware version string 2

– Version String3 Firmware version string 3

– Acceleration Dataset containing data from the accelerometers (Nx3)

* Units Attribute string containing the acceleration units (m/s2)

– Angular Velocity Dataset containing data from the gyroscopes (Nx3)

* Units Attribute string containing the angular velocity units (rad/s)

– Magnetic Field Dataset containing data from the magnetometers (Nx3)

* Units Attribute string containing the magnetic field units (a.u.)

– Temperature Dataset containing the temperature of the monitor (Nx1)

* Units Attribute string containing the temperature units (◦C)

– Temperature Derivative Dataset containing the rate of change of temperature

* Units Attribute string containing the temperature derivative units (◦C/s)

– Sync Value Dataset containing the internal timestamp of each sample

* Units Attribute string containing the timestamp units (1/2560th of a second since 0:00 Jan 1, 1970 UTC)

* Time Dataset containing the time for each sample in microseconds since 0:00 Jan 1, 1970 UTC

Additional fields present when raw data is also stored:

• Opal XX/

– Calibration Data Attribute containing binary block of calibration data

– Raw File Version Attribute containing the version string of the raw file (if this was converted from a .apdm file instead

of streamed)

– Accelerometers Raw Dataset containing raw accelerometer data (Nx3)

– Gyroscopes Raw Dataset containing raw gyroscope data (Nx3)

– Magnetometers Raw Dataset containing raw magnetometer data (Nx3)

– Data Flags Dataset containing flags used for processing the raw data
11



1 Working with HDF5 Files

– Opt Data Dataset containing several measurements taken at a low data rate

– Temperature Raw Dataset containing lowpass filtered, but uncalibrated temperature data (Nx1)

1.4 Working with HDF 5 in MATLAB

MATLAB contains two high level functions for working with HDF5 files. Additional help and examples are

included in the built in help documentation for these functions.

hdf5info reads the structure of the file and all of the attribute values and returns them in an easy to browse

MATLAB structure.

hdf5read reads a complete dataset or attribute from the HDF5 file.

Additionally, one more high level helper function is included with the APDM movement monitor software. This

function also contains built in help documentation and examples.

hdf5readslab reads a portion of a dataset from the HDF5 file.

1.5 Examples

Below is simple example of loading acceleration data from an APDM movement monitor HDF5 file (version

2 or later) in MATLAB. For version 1 files, the dataset paths simply need to be changed to match the format

listed above.

filename = 'example.h5';

try

vers = hdf5read(filename, '/FileFormatVersion');

catch

try

vers = hdf5read(filename, '/File_Format_Version');

catch

error('Couldn''t determine file format');

end

end

if vers< 2

error('This example only works with version 2 or later of the data file')

end

caseIdList = hdf5read(filename, '/CaseIdList');

groupName = caseIdList(1).data;

accPath = [groupName '/Calibrated/Accelerometers'];

fs = hdf5read(filename, [groupName '/SampleRate']);

12



1 Working with HDF5 Files

fs = double(fs);

acc = hdf5read(filename, accPath)'; %Transposed to make Nx3 in MATLAB}

t = (1:size(acc,1))/fs;

figure;

plot(t,acc);

A more complicated example using the flexibility of HDF5 to load and process only part of a data set. This

can be useful when the data set is too large to fit into memory. Care is taken not to attempt to read beyond

the end of the file.

filename = 'example.h5';

try

vers = hdf5read(filename, '/FileFormatVersion');

catch

try

vers = hdf5read(filename, '/File_Format_Version');

catch

error('Couldn''t determine file format');

end

end

if vers < 2

error('This example only works with version 2 or later of the data file')

end

idList = hdf5read(filename, '/CaseIdList');

groupName = idList(1).data;

accPath = [groupName '/Calibrated/Accelerometers'];

fs = hdf5read(filename, [groupName '/SampleRate']);

fs = double(fs);

fhandle = H5F.open(filename, 'H5F_ACC_RDONLY', 'H5P_DEFAULT');

dset = H5D.open(fhandle, [groupName '/Calibrated/Accelerometers'], 'H5P_DEFAULT');

dspace = H5D.get_space(dset);

[ndims, dims] = H5S.get_simple_extent_dims(dspace);

nSamples = dims(1);

nSamplesRead = min(nSamples, 60*fs); %read at most one minute of data

accSegment = hdf5readslab(filename, accPath, [0,0], [nSamplesRead, 3])';

t = (1:nSamplesRead)/fs;

figure;

plot(t,accSegment);

1.6 Notes

• Arrays in MATLAB use the FORTRAN convention of storing them in memory by column then row,

instead of the C convention (used by HDF 5) of row then column. This has the effect of making the
13
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returned arrays transposed from how this document (and many other interfaces to HDF5) claim they

are laid out.

• Older versions of MATLAB (before 2009a) did not support the compression used in Mobility Lab’s HDF

5 files. If you are using one of these older versions, the free h5repack utility available from the HDF

Group can remove the compression. This utility is available at:

http://www.hdfgroup.org/HDF5/release/obtain5.html

The command to repack the file is:
h5repack -f NONE example.h5 example_no_compression.h5
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2 Working With Video
Mobility Lab comes with the functionality to collect video that is synchronized with your inertial recordings. In

other words, when you start/strop a recording in Mobility Lab, the connected video camera(s) will start/stop

at the same time. Currently, Apple iDevices (iPhone, iPad, and iPod) devices running the Videography app

are supported.

2.1 Using Videography and Apple iDevices

The iDevices solution makes use of an app available on the Apple Store named Videography (http://

appologics.com/videography). This software must be purchased and installed on each iDevice that you

wish to use. Videography must be the open, running application on the iDevice in order for it to be triggerable.

2.1.1 Network Setup

The Videography cameras and the computer running Mobility Lab need to be mutually reachable on the

network. There are three possible configurations:

• Common Local network: In this configuration, your computer and the Videography cameras are all

connected to the same local Wi-Fi network. Typically, this means that these devices are all on the same

subnet, meaning that the first 3 octets of the 4-octet IP addresses are the same on your computer and

all connected iDevices. For example, your computer may have the IP address 192.168.1.10 and your

cameras may have IP addresses 192.168.1.11 and 192.168.1.12. This is the easiest setup to use, as

your devices maintain internet access to the outside world through the standard internet connection.

• Ad-hoc network: In this configuration, you create an ad-hoc network on your computer running Mobility

Lab and connect each Videography camera to this network individually. In this mode, your computer

running Mobility Lab and the Videography cameras may not have access to the internet, unless you

configure your computer to use a different network connection while its Wi-Fi adapter is being used

for the ad-hoc network (e.g., you can use Ethernet for your internet connection and the ad-hoc Wi-Fi

network for camera control). This option is useful when no other Wi-Fi network is available.

• Different Wi-Fi networks: Even if the laptop and your Videography cameras are on different networks,

such as two different Wi-Fi access points within one clinic or two computers in different cities, it may still

be possible to remotely control them. The key requirement is that the IP address of the Videography

cameras is reachable on port 80 (the standard web port). This may, however, require some advanced

networking practices, such as port forwarding.
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2.1.2 Camera Configuration

• Enable the use of Videography cameras:

– Click View→Options in the File Menu.

– Select ”Enable Videography video integration”

– Click ”Done” and restart the application

The Videography Camera Configuration Dialog

• Click Video→”Manage Videography Cameras”. You will see a configuration dialog similar to the one

above.

• If your computer and all Videography cameras are on the same Wi-Fi network, you can use the Auto-

Detect Cameras feature to automatically find and add your Videography cameras. Please note that

this takes 20s or so. Alternately, you can add the IP address of each camera individually in the text field

at the top and clicking on the ”Add Camera at http://” button. Note: You can determine the IP address

of the Videography camera by clicking on Settings→”Remote Control” and looking at the Wi-Fi address

field.

• If you wish to configure your camera, select it in the dropdown list and click the Configure button.

Note: You can access the same configuration dialog through a web browser by entering the camera’s

IP address into the browser’s address field or by using the software’s configuration options directly

through the iDevice.

• You can select the Automatically Transfer Video option if you want video to be transferred back to

your computer immediately following the video capture. Due to the potentially large size of the video

files, you may want to avoid this if you are collecting long video segments with brief periods of inactivity

between them or if your network speeds are slow, as active video transfers may interfere with an active

recording session. Videos can easily be transferred using the video management tool at a later time.

• If a Videography camera is listed here that you no longer wish to trigger, select it and click the Remove

button.
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2.1.3 Triggering The Camera

• When you open up the recording dialog, a Videography widget will be visible among the recording

controls. This widget will indicate how many cameras are configured for recording. Communication

with each configured camera is checked when the recording dialog is opened, so it is possible that one

or more expected cameras do not appear on this list if they are experiencing network issues, have shut

down, have switched to another application, etc. If the list doesn’t match up with your expectations,

click on the Videography icon within this widget to re-open the configuration dialog.

• When you start an inertial recording from within Mobility Lab, the camera(s) will start recording (each

camera will display on its own screen that it is recording). When you hit stop, the camera will stop

recording.

• If you have the ”Automatically Transfer Videos?” option set, the video will be transferred to the computer

running Mobility Lab. If not, you can use the Video Manager to transfer and view these files at a later

time.

2.1.4 Managing Videography Videos

The Video Management Tool

All recorded Videography videos will be logged in the Video Management Tool. This tool will help you

keep track of when the recordings were made, which inertial recordings they are associated with, properties

of each video (e.g., resolution, size), and whether the video has been transferred from the camera to your

computer yet.
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• The videos will end up in the following folder:

INSTALL FOLDER\Mobility Lab\workspace\CURRENT PROJECT FOLDER\videos

If you are using Mobility Lab, the CURRENT PROJECT FOLDER is named ”MobilityLabProject”

• Video Properties:

– Time of Recording: The time when both the inertial and video recording were initiated.

– Duration: The duration of the recording

– Resolution: The video resolution

– Size: The disk size of the video recording

– Camera: The name of the iDevice running Videography.

– File name: The name of the video file after it has been transferred. This matches the name of the

recorded inertial file, with an addition to identify the source camera (needed if multiple cameras

are used for simultaneous video).

– Retrieved: Whether the video has been transferred from the remote camera to your computer yet.

• Actions

– Transfer Selected: Transfer any selected videos from the remote camera to your computer. The

iDevices that you are transferring the videos from must all be running Videography and must be

connected through the use of the Camera Configuration Dialog. You can click on the ”Manage

Cameras” button on the bottom of the dialog to open up the Camera Configuration Dialog.

– Transfer Untransferred: Transfer any videos that have not yet been retrieved.

– Remove Selected: Remove the selected video(s) from the video log.

– Play Video: Play the selected video. This function only works if the video has already been

transferred.

• Note: We do not currently have a tool to view raw inertial data along side the video(s), but this is planned

for a future release. These videos should be playable on any modern computer. If you have issues with

playback, try downloading VLC (http://www.videolan.org/vlc/index.html)

2.1.5 Synchronization Performance

We have measured the following characteristics regarding synchronization between the video and inertial

recordings:

• Mean synchronization error : 100ms

• Standard deviation of the synchronization error: 80ms

• Max synchronization error: 250ms

This variability comes from the communication overhead and when the iDevice actually starts recording. This

should be sufficient for most types of recordings, but may be slightly inaccurate when looking at very fast or

brief actions.
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3 Firmware Updates
Firmware controls the various hardware components of your APDM product line (monitors, access points,

and docking stations). It is important to keep the firmware up to date to ensure that your system gets the

latest bug fixes and has access to the latest features. Firmware updates are bundled with updates to Mobility

Lab. Firmware can be updated either automatically or manually.

3.1 Automatic Firmware Updates

Whenever you configure your system, your hardware is first checked to ensure that the latest firmware is

installed. If not, you will be prompted to automatically update your hardware to the latest versions of the

firmware bundled with your system.

3.2 Manual Firmware Updates

Firmware can be updated manually as well. This functionality can be used to either flash the default firmware

to one of the hardware components, or to flash a different version. To access the “Update Firmware” dialog,

click on “Tools→ Update Firmware” in the menu bar.

The manual firmware update tool

3.2.1 Flash Default Firmware

Your system comes bundled with an up to date version of the firmware. Pressing this button will re-flash this

version of the firmware onto the specified monitor.

3.2.2 Flash Alternate Firmware

For testing purposes or to address an issue in a timely fashion, it may be necessary to flash a monitor with

a version of the firmware that is different than the bundled version. You will have to specify the alternate

firmware file to use with this option.
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3.2.3 Force Update

When using either of the options above, if the firmware version on the target device(s) matches the firmware

version to be flashed, the device will be skipped. If the “Force update even if versions match” checkbox is

selected, however, the firmware will be flashed even if the versions match. This may be necessary in some

cases to recover a malfunctioning device.
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4 Calibration

4.1 Sensor Error Models

The errors modeled and compensated for by the calibration are: scale factor, cross axis sensitivity, sen-

sor misalignment, and bias. For scale factor, there is a linear temperature model, and for bias, a look up

table based temperature model. The notation is reused, but each type of sensor has distinct calibration

parameters. For example, the scale factor matrix S T for the accelerometers is different from the one for the

gyroscopes, and from the one used for the magnetometers. APDM factory calibration does not compensate

for misalignment between the sensors and the case, only misalignment between the accelerometers and the

other two sensors.

4.1.1 Accelerometers

The calibrated accelerometer measurements are calculated as

~acal = CS T (~araw − ~bT )

C =


cos sxy cos sxz sin sxy sin sxz

sin sxy cos sxy cos syz sin syz

sin sxz sin syz cos sxz cos syz


S T =


sx + T sx,T 0 0

0 sy + T sy,T 0
0 0 sz + T sz,T


~bT =


bx,T

by,T

bz,T


where C is the cross axis sensitivity matrix, S T is the temperature dependent scale factor matrix, and ~bT is

the temperature dependent bias vector. There is a look up table for the temperature effect on bias for each

sensor axis. The bias value for a particular temperature is linearly interpolated from this table.
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4.1.2 Gyroscopes

The calibrated gyroscope measurements are calculated as

~ωcal = MCS T (~ωraw − ~bT )

M =


1 0 0
0 cos θr − sin θr

0 sin θr cos θr




cos θp 0 sin θp

0 1 0
− sin θp 0 cos θp




cos θy sin θy 0
− sin θy cos θy 0

0 0 1


C =


cos sxy cos sxz sin sxy sin sxz

sin sxy cos sxy cos syz sin syz

sin sxz sin syz cos sxz cos syz


S T =


sx + T sx,T 0 0

0 sy + T sy,T 0
0 0 sz + T sz,T


~bT =


bx,T

by,T

bz,T


where M is the misalignment matrix, C is the cross axis sensitivity matrix, S T is the temperature dependent

scale factor matrix, and ~bT is the temperature dependent bias vector. There is a look up table for the temper-

ature effect on bias for each sensor axis. The bias value for a particular temperature is linearly interpolated

from this table.
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4.1.3 Magnetometers

The calibrated magnetometer measurements are calculated as

~mcal = MCS T (~mraw − ~bT )

M =


1 0 0
0 cos θr − sin θr

0 sin θr cos θr




cos θp 0 sin θp

0 1 0
− sin θp 0 cos θp




cos θy sin θy 0
− sin θy cos θy 0

0 0 1


C =


cos sxy cos sxz sin sxy sin sxz

sin sxy cos sxy cos syz sin syz

sin sxz sin syz cos sxz cos syz


S T =


sx + T sx,T 0 0

0 sy + T sy,T 0
0 0 sz + T sz,T


~bT =


bx,T

by,T

bz,T


where M is the misalignment matrix, C is the cross axis sensitivity matrix, S T is the temperature dependent

scale factor matrix, and ~bT is the temperature dependent bias vector. There is a look up table for the temper-

ature effect on bias for each sensor axis. The bias value for a particular temperature is linearly interpolated

from this table.

4.1.4 Temperature

The calibrated temperature measurements are calculated as

Tc = s(Tr − b20) + 20,

where s is the scale factor, Tr is the raw sensor reading, and b20 is the raw temperature value at 20 degrees

Celsius.

4.2 Factory Calibration

Your monitors come pre-calibrated from APDM. Each monitor is calibrated individually in a procedure that de-

termines optimal scaling factors and offsets for the accelerometers, gyroscopes, and magnetometers across

a wide range of orientations and temperatures.
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4.2.1 Updating Factory Calibration

There may be rare cases where the factory calibration data is deleted from your monitor(s) due to an issue

with the SD card. In these scenarios, it may be necessary to re-flash the factory calibration onto your monitor

using the “Flash Factory Calibration” button in the monitor tab of the configuration dialog. If you believe that

you have a poorly calibrated monitor and would like to discuss your options, contact our support team using

the contact information provided in Section 10.

4.3 User Calibration

While the factory calibration is optimal at the time of shipping, all low power sensors like the ones used in

APDM’s monitor’s are subject to small changes over time and may require re-calibration. This is something

that can be done by APDM, but we are also dedicated to providing tools to enable end users to recalibrate

their own devices.

4.3.1 Magnetometer Recalibration

To perform this task, click on the “Tools”→“Recalibrate Magnetometer” option in the menu bar. This wizard

will guide you through the process of recalibrating the magnetometers on your monitor(s). The wizard asks

that you only undock and collect calibration data one monitor at a time, because they must each be moved

independently away from other objects that may disrupt the magnetic field (including other monitors).

4.3.2 Gyroscope Recalibration

To perform this task, click on the “Tools”→“Recalibrate Gyroscopes” option in the menu bar. This wizard

will guide you through the process of recalibrating the gyroscopes on your monitor(s). This process can be

applied to all of your monitors simultaneously.

4.3.3 Accelerometer Recalibration

Coming soon!

4.4 Clearing User Calibration

If you wish to revert to the factory calibration settings, you can clear any user calibration that you have applied.

This can be accomplished through the “Clear User Calibration” button in the monitor tab of the configuration

dialog.

24



5 External Synchronization and I/O

5 External Synchronization and I/O
The access point comes with external connectors that enable you to synchronize the recording of data in

Mobility Lab with external equipment. This functionality only works when the system is configured in one of

the wireless streaming modes and the “Stream” dialog is open. The implementation is adaptable to a number

of scenarios. Here are some examples of things you can do:

• Trigger recording in Mobility Lab when external events occur. You can use this functionality to precisely

synchronize your inertial recordings with, for example, recordings initiated on a camera based motion

capture system.

• Trigger external events when you start and stop recording in Mobility Lab. You can use this functionality

to precisely synchronize your inertial recordings initiated in Mobility Lab with, to use another example,

a video recording system.

• A combination of the two. For example, hitting the record button on a camera based motion capture

system could trigger recording in Mobility Lab which could then trigger a video recording system.

The External Synchronization Configuration Dialog
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5.1 Configuration

Specification of external synchronization options is performed through the External Synchronization Con-

figuration dialog. If multiple access points are being used, synchronization options are specified for each

access point individually so that you can determine which ones are receiving external signals and/or sending

external signals. Each access point can have its input and output triggers specified individually. Input and

output triggers can also be disabled through the configuration dialog.

5.2 Input Synchronization

Input synchronization trigger types

5.2.1 Input Trigger Shape

The input trigger shape indicates the type of signal that will be input into the specified access point and

how you want Mobility Lab to respond when using the “Stream” dialog. In the figure above, the four basic

trigger shapes are shown. The solid black line represents the external synchronization signal being sent to

the access point. The blue shaded region represents the period that will be recorded in Mobility Lab. Input

triggers are only processed when the “External Sync” option is specified in the “Record Duration” panel of

the “Stream” dialog.

5.2.2 Input Trigger Level

Input triggers can be either low or high, depending on the nature of the signal generated by your external

synchronization source.
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5.2.3 Input Trigger

There are three input trigger options available:

• Start: The external trigger will only be used to start recording in Mobility Lab.

• End: The external trigger will only be used to stop recording in Mobility Lab.

• Both: The external trigger will be used to start and stop recording in Mobility Lab.

5.2.4 Sample Selection with External Input Trigger Events

The time of the external input trigger events may not align exactly with the time of an individual samples being

collected in Mobility Lab due to the discreet sampling interval. If the start trigger event time does happen

to align exactly with a sample captured in Mobility Lab, the first sample recorded will correspond exactly to

the time of the start trigger event. If these do not align exactly (as will generally be the case) the sample

preceding the start trigger event will be the first sample recorded. Similarly, if the stop trigger event aligns

exactly with a sample captured in Mobility Lab, the last sample recorded will correspond exactly to the time

of the stop trigger event. If these do not align exactly, the sample following the start trigger event will be the

last sample recorded. This way, we guarantee that the recording captured in Mobility Lab fully spans the time

period between the external input start and stop events, but no more.

5.2.5 Annotation of Externally Triggered Recordings

Note: Annotations are implemented for the HDF file format only. When an external “Start” trigger event is

detected, an annotation is added to the recording that indicates the name of the event (in this case “External

trigger start time”) along with the timestamp of the event in epoch microseconds. Similarly, when an external

“Stop” trigger event is detected, a timestamped annotation is added to the recording (in this case labeled

as the “External trigger stop time”). These annotations allow you to align the recording captured in Mobility

Lab with your external events in the case where the external trigger event times do not exactly align with the

samples captured in your HDF file.

5.3 Output Synchronization

5.3.1 Output Trigger Shape

The output trigger shape indicates the type of signal that will be generated by the specified access point

when recording is started and stopped through the streaming dialog in Mobility Lab. The output trigger

shapes are identical to the input trigger shapes, but in this case the solid black line in the figure above

represents the signal being output by the configured access point. The blue shaded region represents the
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Output synchronization trigger types

period being recorded in Mobility Lab, initiated either through user selection of the start/stop buttons in the

“Stream” dialog, use of the wireless remote, or an external synchronization event. Unlike input triggers,

output triggers are processed even if the “External Sync” option is not specified in the “Record Duration”

panel of the “Stream” dialog.

5.3.2 Output Trigger Level

Output triggers can be either low or high, depending on the requirements of the external system receiving

the synchronization signal.

5.3.3 Output Trigger

There are three output trigger options available:

• Start: The external signal will only be generated when recording is started in Mobility Lab.

• End: The external signal will only be generated when recording is stopped in Mobility Lab.

• Both: The external signal will be generated when recording is started and stopped in Mobility Lab.

• Note: It is not recommended to use the level trigger shapes in conjunction with the start or end triggers.

This is because the output signal will be in an undeterministic state prior to the trigger event.

5.4 Isolated External Interface Details

APDM’s access points come fitted with a 6 pin digital I/O connector and a 4 pin analog I/O connector. To

connect an access point to your external equipment, you may have to create a custom cable that can interface

with both components. Below we provide the technical specifications necessary to complete this task. Feel

free to contact our technical support at support@apdm.com if you require assistance or have additional

questions.
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The Isolated External Interface for the AP consists of an auxiliary power supply, two GPIO lines (one in, one

out), and an inter-AP sync signal. All signals in the isolated external interface section (including power and

ground) are isolated from the remainder of the board using an RF solution similar in operation to an opto-

isolator. Further, all signals in the isolated external interface are 5V tolerant and ESD protected beyond the

15kV human body model.

The connectors used in the isolated interface consist of one standard female RCA, and one female 6 pin

mini-din connector. The RCA connector mates to almost any basic RCA cable similar to those used in audio

systems. When choosing an RCA mating connector, choose one that has uncovered bare shield spades to

allow the connector to fit fully into the recessed hollow in the AP body.

The 6 pin mini-din connector is similar to those used for older style PS/2 keyboards and mice. Choose a

connector that is small enough to fit fully inside the recessed hollow in the AP body. Some PS/2 extension

cables can be cut into excellent pigtails for this connector.

5.4.1 RCA Inter-AP Sync Connector

• RCA Connector: Digikey Part number RCP-021, CUI INC

• Center Pin: Inter-AP Sync

• Sheild: Isolated Ground

5.4.2 6 Pin Digital Input/Output Connector

• 6 Pin Mating Connector: Digikey part number CP-2060-ND, CUI Inc part number MD-60.

• 6 Pin Mating Pig Tail Cable: Digikey part number 839-1051-ND

• Note these connectors may need the outer shell trimmed to fit into the AP case, a better solution is

often pigtail cables that have over-molded ends and excellent strain relief.

AP 6 Pin Digital Connector

• Pin 1: Record In
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• Pin 2: Output Voltage Select. When connected to positive (pin 6), I/O will be in 5 volt mode. 3.3 volt

mode otherwise.

• Pin 3: Isolated Ground (isolated gnd)

• Pin 4: Inter-AP synchronization output signal. 2.56 khz square wave used for synchronizing timing

among multiple access points.

• Pin 5: Record Out

• Pin 6: Isolated Vdd, unregulated. 3.3 V or 5 V depending on whether it is connected to pin 2.

The auxiliary power supply is meant to provide for powered external interface solutions, allowing a small

circuit to be powered directly from the AP. Accessed via pin 6 of the mini-din connector, the auxiliary power

supply is rated for operation up to 250mW at 3.3V or 5V operation. While default operation is at 3.3V, 5V

operation can be selected by shorting pin 2 to pin 6 of the 6 pin mini-din connector.

The inter-AP sync signal is a 2.56kHz clock signal used to keep multiple AP configurations in sync with one

another. The inter-AP sync signal is available on the RCA connector, as well as pin 4 of the 6 pin mini-din

connector next to it. The signal is a square wave pulse that is driven by the ’master’ AP (usually the first AP

to enumerate) and received by up to seven additional APs (depending on output voltage selection and cable

length). In operation the signal is weakly pulled up to the isolated power rail by each AP in the system, and

driven directly to ground only by the ’master’ AP to produce the pulsed waveform.

Two GPIO lines are available, one input and one output. Both are pulled down by 47.5kΩ resistors, and

each have a series resistance of nearly 1.2kΩ due to the methods used to protect the lines from over-

voltage/overcurrent conditions. The input signal is available on pin 1 of the 6 pin mini-din connector and

is typically used to start/stop data collection by the host PC. Driving the line high to ’record’ and low to

’not-record’ is the default operation, though this is user selectable in software to allow for other modes of

operation. Similar to the input line, the output line is typically used to start/stop data capture on external

systems. The line is driven high by the AP when ’start recording’ is selected in software, and driven low when

recording stops. Opposite high/low operation can be software selected at time of configuration for both input

and output signals.

• Note: The pin diagrams below show the interface on the AP and not the cable. The pin layout on the

cable is the mirror image of these diagrams.

• Note: A cable designed to trigger recording in Mobility Lab from an external synchronization event must

make use of isolated ground (pin 3) and record in (pin 1). Assuming a voltage range of 3.3V, these are

the only pins that need to be implemented. If the voltage range is 5V, pins 2 and 6 must be connected.

• Note: A cable designed to trigger an external system when recording is started or stopped in Mobility

Lab must make use of isolated ground (pin 3) and record out (pin 5). Assuming a voltage range of 3.3V,

these are the only pins that need to be implemented. If the voltage range is 5V, pins 2 and 6 must be

connected.
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5 External Synchronization and I/O

5.4.3 External Sync Box

The external sync box is meant to allow for easy access to the access point external digital expansion port.

A shielded straight-through six conductor cable connects the AP to the sync box, BNC connections outside

the box allow for simple connections to remote equipment.

AP External Sync Box

Three external BNC connections:

• AP-AP: This connection should only be connected to another AP, it is used to keep multiple APs in sync

and can be used to connect multiple APs in a star or daisy chain configuration (both will work).

• AP In: This input to the AP can be configured via software to allow an external device to begin and stop

recordings. Accepts both +3.3V and +5V logic levels.

• AP Out: This AP output can be configured via software to drive low, high, or pulse at record start/stop

points allowing synchronization with an external system (such as a camera motion capture system).

Note: the default configuration for AP Out is +3.3V logic levels, though +5V levels can be selected

using the voltage select switch located in the top of the box.

Four LEDs indicators:

• PWR: Lights when power is applied to the external interface.

• +5V: Lights to indicate that the external interface is configured for 5V operation. Default is 3.3V (Light

out)

• AP In: Lights to indicate that the APlIn signal is High

• AP Out: Lights to indicate that the AP Out signal is High

Push-button and Toggle switch:

• Push Button: Up to select 3.3V operation. Down to select 5V operation.

• Toggle: Manually ties the AP In signal to the positive voltage rail allowing for manual triggering of

recordings (software configured).
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5 External Synchronization and I/O

Additional connections and functionality are located inside the box and can be accessed by removal of the

box top: JP1 through JP4 can be removed to disconnect the corresponding LED.

Six Euro-style screw terminals can be used to directly connect to the six wires in the AP cable:

AP External Sync Box

• +V: Positive voltage rail from the isolated supply located inside the AP.

• GND: Ground rail from the isolated supply located inside the AP.

• VSEL: Tie to Ground or leave floating to select output and +V operation at +3.3V, tie to +V to select +5V

operation.

• AP-AP: Allows multiple AP configurations, tie only to the same port of another AP.

• AP Out: Digital output from the AP. Default is 0V to +3.3V, but can be configured for 0-5V operation.

• AP In: Digital input to the AP from an external source or the manual trigger toggle switch.

Note: The AP is able to safely source only 50mA on the +V rail.
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5 External Synchronization and I/O

5.4.4 4 Pin Analog Input/Output Connector

Note: This connector is currently reserved for future expansion.

• 4 Pin Mating Connector: Digikey part number CP-2040-ND, CUI Inc part number MD-40

• 4 Pin Mating Pig Tail Cable: Digikey part number 839-1049-ND

AP 4 Pin Analog Connector

• Pin 1: Analog In (0 to 6 volts)

• Pin 2: Analog Out (0 to 5 volts or 0 to 3.3 volts depending on software controled configuration)

• Pin 3: No Connect (reserved for future use, avoid connecting this pin)

• Pin 4: Ground (gnd). This is the same ground as USB, and depending on how your USB hub and/or

laptop are designed electrically, may also be the same ground as the hub and laptop. Consideration

should be taken for ground loops.

5.4.5 Schematic
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6 Movement Monitor Reference

6 Movement Monitor Reference

6.1 Charging

A movement monitor charges its internal battery any time it is connected to a docking station. At the optimal

charge rate the movement monitors internal battery will complete its bulk charge (80%-90%) within an hour

for a fully discharged battery. It is recommended that the movement monitor be charged for up to 3 hours to

provide a peak charge to the battery ensuring it has the longest run time and improves battery life.

Warning: Your movement monitor uses a lithium battery. This battery may only be charged over a limited

temperature range. Never attempt to dock or charge your Opal when the temperature experienced can be

outside the range of 0 to 45 degrees Celsius (32 to 113 degrees Fahrenheit). The recommended charging

and docking temperature range is between 5 to 35 degrees Celsius (40 to 95 degrees Fahrenheit).

6.2 Powering Down

If you wish to power down your monitors for storage or travel, dock the monitors you wish to power down

and click on the “Power Off” button in Mobility Lab. After this process is complete, these monitors will power

down when they are undocked. They can be powered back on by re-applying the saved configuration or

re-configuring the system.

6.3 Data Storage

The movement monitors utilize a flash card to store data while logging. This data can be downloaded by

using a docking station to dock the movement monitor. When the movement monitor is docked it finishes up

writing to the internal flash card and then releases it to the docking station. At this time the docking station

indicates to the PC that there is a new read only removable drive to be mounted. Using your file browser

you can navigate to the removable drive and copy the files off of it. The files are in a proprietary raw format

and need to be converted to either a HDF5 or CSV format that will provide data in calibrated SI units. This

conversion happens automatically if Mobility Labis used to import the data. Alternately, there are functions

in the SDK to do this conversion programmatically.

6.4 Cleaning

Cleaning the movement monitors case should be done by wiping the bottom of the case where it contacts

the skin with Rubbing alcohol or other cleaning wipe. If the entire case needs to be cleaned use only an ethyl

alcohol or isopropyl alcohol based wipe. Methyl alcohol should be avoided for cleaning the top since it will
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6 Movement Monitor Reference

cause degradation of the plastic over time. The movement monitor should not be submerged in any liquids or

subjected to any high temperatures for cleaning. The straps on the monitor can be cleaned by wiping them

down with Rubbing alcohol. Alternatively the straps can be removed and washed separately using mild soap

and water.

6.5 Storage

Storage of the movement monitor should be in a dry static fee location. An anti-static bag or in the supplied

case is recommended. The movement monitor should also not be subjected to any large G forces to prevent

damage or changes to the calibration of the sensors in the monitor. It is recommended for the health of the

battery to to have at least a bulk charge during storage.

6.6 Drivers

Drivers are provided as part of the library distribution and Mobility Lab. The drivers are installed automatically

as part of the Mobility Lab installation process.

6.7 Firmware Updates

Updating the movement monitor firmware should be done using the Mobility Lab software. This process is

detailed in Section 3 of this document.

6.8 Technical Specifications

• The accelerometer range is ±58.8 m/ s2 (6 g) (optionally ±19.6 m/ s2 (2 g)).

• Accelerometers have a typical noise density of 1.3 mm/ s2/
√

Hz.

• The X and Y axis gyros have a range of ±34.9 rad/s (2000 dps)

• The Z axis gyro has a range of ±26.8 rad/s (1500 dps)

• The X and Y axis gyros have a typical noise density of 0.81 mrad/ s/
√

Hz

• The Z axis gyro have a typical noise density of 2.2 mrad/ s/
√

Hz

• Magnetometers have a range of ±6 Gauss

• The magnetometers have a typical noise density is 160 nT/
√

Hz

• Positive X is pointing from the monitor toward the connector. Looking top down at the monitor with

positive X pointing away from you, positive Y is pointing left. Z is pointing up out of the top of the case.

Angular velocity sign is defined according to a right hand rule. A counterclockwise rotation about the Z

axis looking from the +Z direction is positive.
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6 Movement Monitor Reference

6.9 LED Reference

6.9.1 Status Codes and LED Colors/Patterns

The LEDs on the access points and movement monitors provide important information about the operating

state of the hardware, including error statuses. The tables below list the LED patterns associated with these

states and can be useful in troubleshooting issues encountered with the hardware.

6.9.2 Movement Monitor LED Reference

Movement monitors contain a RGB LED capable of outputting a wide array of colors to the user to indicate

its current state. The following colors are used: white (�), red (�), yellow (�), green (�), cyan (�), blue (�),

magenta (�), and led off ( ). In the off state the LED will appear as a non illuminated white dot in the corner

of the monitor opposite the docking connector. All LED patterns are output on a repeating cycle which may

vary in period depending on the pattern. In all cases the last color listed will stay constant until the pattern

repeats. For example “� � ” will blink yellow twice and then stay off until the pattern repeats.
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6 Movement Monitor Reference

State LED Pattern

Startup Mode (boot loader)

Startup wait (5 sec) v1.0, bootloader v1 �

Startup wait (5 sec) v1.1, bootloader v2 �

Failed to load firmware �

Boot loader mode �

Firmware Mode

Docked mode (pre-charging – very low battery) ��

Docked mode (bulk charging – low battery) ��(fast)

Docked mode (trickle charging – 80-100% charge) ��(slow)

Docked mode (full charge) �

Docked mode (battery error) ��

Docked mode (wait) �

Docked mode (error) � � �

Reset mode �

Transitioning into standby or powering off �

Hold mode �

Run mode (battery level 4, full) � � � �

Run mode (battery level 3) � � �

Run mode (battery level 2) � �

Run mode (battery level 1, low) �

Run mode (battery very low) � � �

Run mode (clock unset, battery level 4, full) � � � � �

Run mode (clock unset, battery level 3) � � � �

Run mode (clock unset, battery level 2) � � �

Run mode (clock unset, battery level 1, low) � �

Run mode (clock unset, battery very low) � � � �

Run mode (no sync-lock, battery level 4, full) � � � � �

Run mode (no sync-lock, battery level 3) � � � �

Run mode (no sync-lock, battery level 2) � � �

Run mode (no sync-lock, battery level 1, low) � �

Run mode (no sync-lock, battery very low) � � � �

Run mode (clock unset, no sync-lock, battery level 4, full) � � � � � �

Run mode (clock unset, no sync-lock, battery level 3) � � � � �

Run mode (clock unset, no sync-lock, battery level 2) � � � �

Run mode (clock unset, no sync-lock, battery level 1, low) � � �

Run mode (clock unset, no sync-lock, battery very low) � � � � �
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6 Movement Monitor Reference

State LED Pattern

Error Modes

Error mode: default � �

Error mode: configuration � � �

Error mode: system � � � �

Error mode: data buffer � � � � �

Error mode: SD buffer � � � � � �

Error mode: SD I/O � � � � � � �

Card is full �

Wireless Streaming Debug LED Modes

Normal �

CPU limited ��

Sync bad ��

CPU limited, Sync bad ��

Missed sync > 0 �

Missed sync > 0, CPU limited ��

Missed sync > 0, Sync bad ��

Missed sync > 0, CPU limited, Sync bad ��
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6 Movement Monitor Reference

6.10 Technical Drawing
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7 Access Point Reference

7 Access Point Reference

7.1 Drivers

Drivers are provided as part of the SDK distribution and Mobility Lab.

7.2 Firmware Updates

Updating the movement monitor firmware should be done using the Mobility Lab software.

7.3 Mounting and Placement

The antennas of the access point are located directly behind the black plastic face of the access point. The

access point(s) should be aimed such that this face is in the approximate direction of the area where the

movement monitors will be used.

7.4 Using Multiple Access Points

Having multiple access points is useful when redundancy is needed or when recording from more than 6

Opals. To configure multiple access points, you must have them attached to your computer via USB at the

time of configuration. Additionally, the access points must be linked via RCA cable (a standard stereo cable).

The rest of the configuration is handled automatically.

7.4.1 Redundancy

In some recording environments, it may be difficult to always maintain line of site from your streaming Opals

to the access point. For example, you may have a bend in a hallway, or you may be operating in a large open

space where you are unlikely to receive a reflected signal if the Opal is pointed away from the access point.

In these scenarios, multiple access points can be used to provide better coverage. The streaming Opals will

communicate with whichever access point is providing the stronger signal.

7.4.2 Streaming from more than 6 Opals

Each access point can communicate with up to 6 Opals simultaneously. You can therefore stream from up to

12 Opals with 2 access points, or 24 Opals with 4 access points.

40



7 Access Point Reference

7.5 LED Reference

Access points contain a RGB LED capable of outputting a wide array of colors to the user to indicate its

current state. The following colors are used: white (�), red (�), yellow (�), green (�), cyan (�), blue (�),

magenta (�), and led off ( ). All LED patterns are output on a repeating cycle which may vary in period

depending on the pattern. In all cases the last color listed will stay constant until the pattern repeats. For

example “� � ” will blink yellow twice and then stay off until the pattern repeats.

State LED Pattern

Access point is powered on and is not receiving data from any monitors �

Access point is receiving data from all monitors and there is no excessive latency for

any of the monitors

�

Access point is receiving data from all monitors but there is excessive latency (>3s) in

one or more monitors. The latency is, however, decreasing (improving). This usually

indicates that one or more monitors was temporarily obstructed and is now catching

up.

��

Access point is receiving data from all monitors but there is excessive latency (>3s) in

one or more monitors which is increasing (getting worse). This usually indicates that

one or more monitors is obstructed and is having trouble transmitting its data.

��

Access point is receiving data from one or more, but not all, of the movement monitors �

Access point is receiving data from one or more monitors that it is not expecting to re-

ceive data (e.g. there is a monitor configured on another computer system streaming

data)

�� or ��

Access point is in low power USB suspend mode. �

Access point firmware error type 3, contact support � � �

Access point firmware error type 4, contact support � � � �

Access point firmware error type 5, contact support � � � � �

Access point SDRAM Memory error, contact support � � � � � � � �

7.6 Mechanical and Electrical Specifications

Weight: 1.2lbs, (550 grams)

Electrical: 290mA at 5V over USB connection
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7 Access Point Reference

7.7 Technical Drawing
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8 Docking Station Reference

8 Docking Station Reference

8.1 Drivers

Drivers are provided as part of the SDK distribution and Mobility Lab.

8.2 Power

• If running a single docking station, it can be powered from:

– a USB cable plugged into a dedicated USB port on your computer

– a USB cable plugged into a a powered USB hub

– a USB cable plugged into a wall adapter (charging only)

– the external AC adapter (charging only)

• If running a chain of 2 or more docking stations:

– For data transfer, both USB and external AC power are required. If a power-related error occurs,

then the docking station will blink yellow until external or power is plugged in.

– if only charging is required, the external AC power must be used

8.3 Mechanical and Electrical Specifications

Weight: 0.2 lbs, (90 grams)

Electrical: 500mA at 5V over USB connection, or 500mA per dock when a chain is supplied by external

power.
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8 Docking Station Reference

8.4 LED Reference

Docking stations contain a RGB LED capable of outputting a wide array of colors to the user to indicate its

current state. The following colors are used: white (�), red (�), yellow (�), green (�), cyan (�), blue (�),

magenta (�), and led off ( ). All LED patterns are output on a repeating cycle which may vary in period

depending on the pattern. In all cases the last color listed will stay constant until the pattern repeats. For

example “� � ” will blink yellow twice and then stay off until the pattern repeats.

State LED Pattern

OK �

Powered off, USB suspended, or booloader pause �

OK, but USB not enumerated �

Power problem. Need to plug in external power or USB

power.

�

Docking in progress �

Docked, but SD unavailable to host �

SD Card mounting in progress � �

SD Card mounted and avaliable to host �

SD card read-access in progress �

USB error �

Error �

Error: SD card mounting error � �

Error: in-dock USB hub problem � � �

Firmware error type 4, contact support � � � �

Firmware error type 5, contact support � � � � �

Firmware error type 6, contact support � � � � � �

Bootloader mode �

Updating firmware �

Hardware Error - DA � � � � � �

Hardware Error - GA � � � � � �

Hardware Error - PA � � � � � �

Hardware Error - UA � � � � � �
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8 Docking Station Reference

8.5 Technical Drawing
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9 Limited Warranty

9 Limited Warranty
This Limited Warranty applies to the APDM equipment and does not apply to related software. All software is

covered by the End-User License Agreement. APDMequipment is covered by the one-year parts & labor

warranty which is void should the customer open the equipment without written authorization or due to

misuse.

1. Warranty of Title. APDM Inc. (“APDM”) warrants solely to the original purchaser (Customer) that (a)

APDM has good title to the Equipment and that, upon Customer’s payment of the purchase price to

APDM, good title to the Equipment will be transferred to Customer.

2. Limited Warranty of Condition and Operation. APDM warrants solely to Customer that when deliv-

ered to purchaser and for a period of one (1) year after the date of delivery to Customer, the Equipment,

will conform in all materials respects to APDM’s published specifications when used as described in

APDM’s written instructions, be in good working order and free of defects in workmanship and mate-

rials. EXCEPT AS OTHERWISE PROVIDED HEREIN, APDM MAKES NO WARRANTY, EXPRESS

OR IMPLIED, AS TO ANY MATTER WHATSOEVER, INCLUDING WITHOUT LIMITATION ANY WAR-

RANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE EXCEPT THOSE

SET FORTH IN THE DESCRIPTION AND DIRECTIONS ON THE LABELING OF THE EQUIPMENT.

UNLESS THE EQUIPMENT IS USED IN ACCORDANCE WITH THE DIRECTIONS ON THE LABEL-

ING AND THE INSTRUCTIONS ACCOMPANYING THE EQUIPMENT, THIS LIMITED WARRANTY

AND ANY WARRANTIES IN SUCH DESCRIPTION SHALL BE VOID AND OF NO EFFECT.

3. Customer’s Exclusive Remedies. If within one (1) year from the date of delivery to Customer the

Equipment does not comply with the foregoing Limited Warranty of Condition and Operation, APDM

will at APDM’s option, repair, replace or refund the purchase price of the defective Equipment free

of charge to the Customer. Customers requesting repair, replacement or refund are required to ship,

the Equipment to APDM at APDM’s facilities in Portland, Oregon, or at such other place as APDM

designates. As a condition of this warranty, Customers must call APDM’s Customer Service Line for

instructions on and prior approval of shipment prior to returning any defective Equipment.

4. Limitation of Liability. APDM SHALL HAVE NO LIABILITY FOR ANY CONSEQUENTIAL, INCIDEN-

TAL, OR SPECIAL DAMAGES BY REASON OF ANY ACT OR OMISSION OR ARISING OUT OF OR

IN CONNECTION WITH THE EQUIPMENT OR ITS RENTAL, DELIVERY, INSTALLATION, MAINTE-

NANCE, OPERATION, PERFORMANCE, OR USE, INCLUDING WITHOUT LIMITATION ANY LOSS

OF USE, LOST REVENUE, LOST PROFITS, OR COST ASSOCIATED WITH DOWNTIME. THE OBLI-

GATIONS CONTAINED IN THIS PARAGRAPH CONTINUE BEYOND THE TERM OF THIS LIMITED

WARRANTY.
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9 Limited Warranty

5. Limitation of Liability. This Limited Warranty shall be governed by, and construed and interpreted in

accordance with, the local laws of the State of Oregon (without application of its conflicts of laws rules).
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10 Troubleshooting

10 Troubleshooting
APDM is pleased to assist you with any issues you encounter using our products or questions you have

about using our products.

Please contact us at:

web: support.apdm.com

email: support@apdm.com
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